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Application of Comparing Brio Datamart to  
Cognos Analysis Studio 
Quick Reference Guide 

 

 Ensure that the correct tables and/or models are selected 
from both the BRIO Financial Management Data Mart and 
the Cognos Cost and Performance Management System.  

  Select appropriate table based on Labor/Non-labor 
costs 

 

 Filter all non-expense accounts and transactions in the 
data mart query for non-labor costs. 

  General Ledger Account 

  Transaction Type 

  Vendor Code 
 

  Filter/exclude all budget object class (BOC) codes not 
included in the activity-based costing model. Refer to 
Appendix A. 

 

  Filter out specific subactivity codes for grant money (BOC 
411G). Refer to Appendix B. 

 

  Crosswalk prior year money (FY 2004, FY 2005) to a 
current ABC code using the crosswalk instructions and 
crosswalk provided in Appendix C. 

 

  Crosswalk all old organization codes to new codes using 
the crosswalk provided in Appendix D. 

 

  If comparing by region, break up Law Enforcement (OLE) by 
region. 
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Application of Comparing Brio Datamart to  
Cognos Analysis Studio 

Detailed Reference Guide 
 

  Ensure that the correct tables and/or models are selected 
from both the BRIO Financial Management Data Mart and 
the Cognos Cost and Performance Management System.  

 
In order to ensure that the data from Brio and the ABC system is 
comparable, you need to make certain that you are querying the correct 
tables in Brio, as well as the correct package in Cognos Analysis Studio. 
The following steps can be used to help you to determine which Brio 
tables you should be using. Always use the Cost – Unloaded package in 
Analysis Studio, as this is the data that does not contain any 
redistributions/assignments of indirect costs. After extracting a view from 
the Cost – Unloaded package, follow the steps below to ensure that the 
costs from Brio follow the same methodology. 
 

o Step 1 – Determine if you are interested in viewing Labor or 
Non-Labor costs. If the answer includes both cost types, you 
will need to follow both the labor and non-labor portions of 
the steps below. 

o Step 2 – Log in to the Division of Financial Management 
Data Mart (Brio) by navigating to 
http://financedatamart.fws.gov/ and selecting ‘Logon’ from 
the main screen.  
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Figure 1: Log on to Brio by selecting ‘Logon’. 

 
o Step 3 – Type your Username and Password in the logon 

screen.  
 

 
Figure 2: Type your username and password on the logon screen. 

 
o Step 4 – Follow either the Labor or Non-Labor cost section 

depending upon what you are interested in viewing. 
 

    Non-Labor Costs 
 Step 1: Once the Brio Reports window opens, 

navigate to the Obligations/Expenditures folder 
 

FWSABC9 
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Figure 3: Select ‘Ad Hoc – CY Spending Journal’ from the Obligations and Expenditures folder. 

 

 Step 2: Open the ‘Ad Hoc – CY Spending Journal’  

 
Figure 4: View of Ad Hoc – CY Spending Journal’ in Brio. 

 Step 3: Proceed to the next item in the checklist 
     
    Labor Costs     

 Step 1: Navigate to the Labor folder 
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Figure 5: Select ‘Ad Hoc – OARC Payroll’ from the Labor folder. 

 

 Step 2: Open the Ad – Hoc OARC Payroll table 
 
Note: When comparing the costs for FY 2008, there 
should be no distinction between payroll redistribution 
and regular payroll transactions. As long as you are 
pulling data for a specific quarter, the costs should 
match. For prior year data, payroll distribution costs were 
handled in a different manner. Due to how the Cognos 
model handles redistributions, you will not be able to 
match to the dollar from the OARC table. Please contact 
PES if you are trying to look at data prior to FY 2008. 
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Figure 6: View of ‘Ad Hoc – OARC Payroll’ in Brio 

 

 Step 3: Proceed to the next item in the checklist 
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 Filter all non-expense accounts and transactions in the 
data mart query for Non-Labor costs (only.). 

 
After selecting the proper table, the next step is to filter out the information 
from Brio that is not used in the calculation of the ABC model. The 
following filters apply only to Non-Labor costs and will not be used to 
filter the labor data. 
 

  General Ledger Account 
The ABC model only includes expenses, therefore in order to 
match the ABC model, you must filter out all other transactions 
from the table. 
 
o Step 1 – Find the GL Acct item in the ‘Ad Hoc – CY 

Spending Journal’. 

 
Figure 7: Locate the GL Acct field in CY Spending Journal 

 
o Step 2 – Double-click the GL Acct in order to set a Limit on 

the field.  
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Figure 8: Open the Limit dialog box for the GL Acct 

 
o Step 3 – Type ‘4901,4902’ into the Custom Values text box 

and select the green check mark.  
 

 
Figure 9: Select GL Accounts 4901 and 4902. 

 
o Step 4 – Click ‘OK’ and ensure that the GL Acct field is now 

in the Limit row. 
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Figure 10: Verify that the GL Acct is a limit. 

 

  Transaction Code 
The ABC model excludes all transaction types that are not equal 
to expense (i.e., revenue, accounting entry).  
 
o Step 1 – Find the Trans Code item in the ‘Ad Hoc – CY 

Spending Journal’. 
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Figure 11: Navigate to the Trans Code field in the CY Spending Journal. 

 
o Step 2 – Double-click the Trans Code field in order to set a 

Limit on the field. 
 

 
Figure 12: Open the Limit dialog box for the Trans Code account 

 
o Step 3 – Type the following into the ‘Custom Values’ area or 

select from ‘Show Values’. Ensure that you have selected 
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the ‘Not’ checkbox since these costs are excluded from the 
ABC model.  

   
Transaction Code
BV 
CG 
CR 
JV 
SV 
YA 
YR 

Figure 13: Transaction Codes excluded from the ABC model. 
 

 
Figure 14: Set the limit for the Transaction Codes in the Limit dialog box. 

 
o Step 4 – Click ‘OK’ and ensure that the Trans Code field is 

now in the Limit row. 
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Figure 15: Verify that Trans Code is a limit. 
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 Vendor Code 
The ABC model excludes all suspense account transactions. These 
transactions can be filtered out of the CY Spending Journal by 
excluding costs where the vendor code contains ‘SUSPENS’. 
 

o Step 1 – Find the Vendor Code field in the ‘Ad Hoc – CY 
Spending Journal’.  

 
Figure 16: Locate the Vendor Code in the CY Spending Journal. Notice, also, that the Trans Code 

that was limited in the previous step now has an equal sign next to it. 
 

 
o Step 2 – Double-click the Vendor Code field in order to set a 

Limit on the field. 
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Figure 17: Set a limit on the Vendor Code in the Limit dialog box. 

 
o Step 3 – Type ‘Suspens-PCS’ into the ‘Custom Values’ area 

and ensure that the ‘Not’ check box is checked next to state 
that vendor code is not equal to ‘Suspens-PCS’. 

 

 
Figure 18: Type ‘Suspens-PCS’ in the text box. Ensure that the checkbox next to ‘Not’ is selected. 

 
o Step 4 – Click ‘OK’ and ensure that the Vendor Code field is 

now in the Limit row. 
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Figure 19: Verify that Vendor Code is a limit. 
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 Filter/exclude all budget object class (BOC) not included in 
the activity-based costing model. Refer to Appendix A. 
 
The next step in this process is to exclude specific budget object class 
(BOC) codes  from ‘Ad Hoc – CY Spending Journal’ query. The ABC 
model contains BOCs for only non-labor costs, therefore you will only 
need to use this filter if you are looking at non-labor costs.  

 
o Step 1 – Find the BOC field in the ‘Ad Hoc – CY Spending 

Journal’.  

 
Figure 20: Locate the BOC field in the CY Spending Journal. 

 
o Step 2 – Double-click the BOC field in order to set a Limit on 

the field. 
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Figure 21: Open the Limit dialog box by double-clicking on the BOC field in the CY Spending 

Journal. 
 

o Step 3 – Type the items in Appendix A into the ‘Custom 
Values’ area or select from ‘Show Values’. Ensure that you 
select the ‘Not’ checkbox as shown below as these costs are 
excluded from the ABC model. 

 

 
Figure 22: Select ‘Show Values’ and select the BOCs listed in Appendix A. 

 
o Step 4 – Click ‘OK’ and ensure that the BOC field is now in 

the Limit row. 
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Figure 23: Verify that the BOC field is a limit. 
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 Filter out specific subactivity codes for grant money (BOC 
411G). Refer to Appendix B. 
 
The ABC model excludes certain grant costs related to specific subactivity 
codes. Again, similar to the previous BOC filter, this filter is only necessary 
for non-labor costs. You will only use this filter when querying the CY 
Spending Journal. Unlike the previous filter this step must be completed 
outside of Brio in a spreadsheet or database environment as there are two 
conditions that must be met. Follow the steps below for the easiest 
method (using Excel) to filter out non-labor costs.  
 

o Step 1 –  Using the File menu in Brio, navigate to File > 
Export > Section… 

 

 
Figure 24: Use the Export Section... menu item to save the query results to Excel. 

 
o Step 2 –  The ‘Export Section’ dialog box will appear. 

Navigate to the area of your computer in which you wish to 
save the file and select ‘Save’. 

 

 
Figure 25: Navigate to the location where you choose to save the file. 
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o Step 3 –  Open the Excel file.  
o Step 4 – Highlight row 1. Then, using the Data menu, 

navigate to Filter > Auto Filter. This will automatically create 
a set of filters for each column in the data set. 

 

 
Figure 26: On the Data menu, navigate to Filter>Auto Filter.  
 
o Step 5 – Locate the BOC column. Click the filter arrow next 

to the column heading. Scroll down until you find ‘411G’ and 
select this BOC. 

o Step 6 – Now that you have filtered on the BOC 411G, you 
can begin to exclude specific subactivities listed in Appendix 
B. Using the filter arrow in the subactivity column, select the 
first Subactivity (5100) listed in Appendix B. If these 
subactivities exist in the data set, delete the rows associated 
with the subactivity. Continue for all subactivities listed in 
Appendix B. 

o Step 7 – Compare the costs between the Brio extract and 
the ABC cost model extract. If they are still off, proceed to 
the next steps.  
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 Crosswalk all prior year’s money to a current ABC code 
using the crosswalk instructions and crosswalk provided in 
Appendix C. 

 
In order to obtain an accurate view of costs, it is necessary to crosswalk 
all prior year’s money to a current ABC code. This process can be 
completed by using the Budget Fiscal Year column in the CY Spending 
Journal. To crosswalk the codes, refer to Appendix C. Like the previous 
step, it is easiest to crosswalk the code in Excel.  
 
Additionally, because the majority of money (85%) is 2006 or 2007 money, 
it may not even be necessary to complete this step. Rather than doing this 
work up front, another option would be to first determine if the costs are 
not matching by activity. If this is the case, then complete the steps below 
as the fiscal year is most likely the reason.   
 

o Step 1 – Open the Excel file containing the Brio data extract 
for the specific organization and/or region that you are 
viewing.  

o Step 2 – Highlight row 1. Then, using the Data menu, 
navigate to Filter > Auto Filter. This will automatically create 
a set of filters for each column in the data set. 

 

 
Figure 27: On the Excel Data menu, navigate to Filter>Auto Filter.  

 
o Step 3 – Locate the BFY (Budget Fiscal Year) column. Click 

the filter arrow next to the column heading.  
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Figure 28: View the distinct budget fiscal years in the data set using the Auto-Filter option. 

 
o Step 4 – If there are budget years prior to FY2006 listed in 

the Filter menu, it will be necessary to crosswalk the activity 
codes. The bullets below detail whether or not crosswalking 
is necessary for a specific Budget Fiscal Year.  

 
• Prior to FY2004 – There were no activity codes 

prior to FY 2004 so it is not necessary to look 
at these fiscal years.  

• FY2004 – The activity codes in FY2004 were 
four digits. In order to crosswalk these codes 
you must first remove the first two characters in 
the character string. The last two characters 
within the code are equivalent to the FY2005 
activity codes. Hint: Create a new column 
and use the right function in Excel and take 
the right two digits. Once you have done so, 
you can crosswalk to the 2-digit code using the 
FY2005 column in the crosswalk in Appendix 
C. 

• FY2005 – Use the FY2005 column listed in the 
crosswalk found in Appendix C to crosswalk 
the codes to the FY2006/FY2007 code. Hint: 
Use the VLookup function in Excel to 
lookup the current code in the crosswalk 
and crosswalk it to an existing 
FY2006/FY2007 activity code. 

• FY2006 to present – The activity codes 
remained consistent between FY2006, 
FY2007, and FY2008 and no crosswalking is 
necessary. 

 
  If it is necessary to crosswalk the ABC codes, first filter on 

the specific budget year using the Auto Filter option in Excel. 
Paste Appendix C into one of the sheets in the Excel 
workbook. After filtering, use the vlookup function in a new 



24 of 46 

column to lookup the current code from Appendix C in your 
Excel workbook.  
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  Crosswalk all old organization codes to new codes using 
the crosswalk provided in Appendix D. 

 
Due to organizations being deleted, added and changed over time, 
another step that may be necessary is to crosswalk old organization codes 
to new organization codes. This step is only necessary when looking 
at costs by organization.  
 
Similar to the previous step, it is easiest to crosswalk the code in Excel. 
Additionally, because crosswalking applies only to a limited set of 
organizations, it may be easiest to first see if the costs match. If they do 
not, then you will want to check the organizations. Complete the steps 
below in order to crosswalk the old organization codes to the new 
organization code.  
 

o Step 1 – Open the Excel file containing the Brio data extract 
for the specific organization and/or region that you are 
viewing.  

o Step 2 – Copy and paste the data from Appendix D into 
another sheet in the Excel workbook.  

o Step 3 – Insert a column to the right of the organization 
column by right-clicking on the column heading next to the 
organization column and selecting insert.  

 

 
Figure 29: Insert a column in the spreadsheet by right-clicking and selecting ‘Insert’. 
 

o Step 4 – Use the vlookup function in Excel to crosswalk the 
organization code listed in the report to the New Org Code 
listed in Appendix D.  

o Step 5 – Sum the costs by organization using the column 
created in the previous step. 
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 If comparing by region, break up Law Enforcement (OLE) by 
region. 

 
 

If comparing costs for Law Enforcement organizations by region, you will 
need to break up the Law Enforcement organizations by location. The 
ABC model is based upon the location of the organization rather than 
rolling all of the OLE organization costs up to the Headquarters level. The 
third digit of the Law Enforcement organization specifies the associated 
region in the ABC model. Use this methodology for comparing costs. For 
example, to compare the costs from Brio with the ABC model for region 1, 
you will need to sum costs for all organizations in Brio that look similar to 
‘991XX’.
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Appendix A: Excluded Budget Object Code 

BOC BOC Description 
311A Capitalized – Equipment 
311B Capitalized - Equipment On Loan 

311D 
Capitalized - Information Technology Software (over 
$100,000) 

311E Capitalized - Information Technology Equipment 
311H Capitalized - Furniture & Fixtures 
311J Capitalized - Copier/Duplicator 
311K Capitalized - Heavy Machinery 
311L Capitalized - Transportation Equipment (Includes Horses) 
321A Capitalized - Land Acquisition 
321E Capitalized - Easements & Right-Of-Way 
322C Capitalized - Bridges – Purchased 
322R Capitalized - Roads – Constructed 
322S Capitalized - Roads – Purchased 
322Z Capitalized - Other Non-Structure Improvements  
323B Capitalized – Buildings 
323C Capitalized – Buildings 
323H Capitalized – Improvements 
323Y Capitalized - Other Structures & Facilities – Constructed 
323Z Capitalized - Other Structures & Facilities—Purchased  
324J Capitalized - Major Machinery & Fixed Equipment 
411P PILT - Other Revenue Sharing 
415A R&D Cooperative Agreements  
431A Interest 
441A Refunds 
910A Unvouchered 
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Appendix B: Excluded Budget Object Code 
 
The following subactivity costs are excluded from the FY 2007 and FY 2008models if the Budget 
Object Code associated with the transaction is 411G. 

Subactivity Code Subactivity Name 
5100 ADMINISTRATION -FEDERAL AID –WL 
510C C.A.M. - FA WILDLIFE 
5110 Wildlife Restoration Administration 
5200 FEDERAL AID -WL –PAYMENTS 
5210 HUNTER EDUCATION 
5220 WILDLIFE RESTORATION 
5230 SEC. 10 HUNTER EDUCATION PROGRAM 
5231 SEC. 10 HUNTER EDUCATION GRANTS 
5232 SEC. 10 WILDLIFE RESTORATION GRANTS 
5390 REVERTED FUNDS -WILDLIFE 
5410 MULTI-STATE CONSERVATION PROJECTS 
5420 NATIONAL SURVEY 
5500 WILDLIFE CONSERV & RESTOR PRO 
5510 WILDLIFE CONSERVATION AND RESTORATION GRANTS 
5511 WCRP CONSERVATION GRANTS 
5512 WCRP RECREATION GRANTS 
5513 WCRP ADMINISTRATION 
551C C.A.M. - WCRP  NO LONGER USED 
5521 WETLANDS CONSERVATION 
5522 GRANTS 
5523 ADMINISTRATION 
5590 REVERTED FUNDS - WCRP 
5664 G.A.S. ADMINISTRATION  NO LONGER USED 
5820 WETLANDS CONSERVATION – INTEREST 
5830 NAWC GRANTS – INTEREST 
5840 NAWC – ADMINISTRATION - INTEREST 
9310 CLEAN VESSEL ACT -GRANT PROGRAM 
9319 CLEAN VESSEL GRANTS FROM ADMINISTRATION   NO LONGE 
9320 CLEAN VESSEL ACT 
9364 CLEAN VESSEL - ADMINISTRATION 
9400 ADMINISTRATION -SPORT FISH 
940C C.A.M. SPORT FISH RESTORATION 
9410 SPORT FISH RESTORATION ADMINISTRATION 
9420 SMALL GRANT PROGRAMS ADMINISTRATION 
9421 COASTAL WETLANDS ADMINISTRATION 
9422 CLEAN VESSEL ACT ADMINISTRATION 
9423 BOATING INFRASTRUCTURE PROGRAM ADMINISTRATION 
9424 OUTREACH & COMMUNICATIONS ADMINISTRATION 
9431 TRANSFER TO COAST GUARD 
9432 TRANSFER TO CORPS OF ENGINEER 
9464 G.A.S.  ADMINISTRATION   NO LONGER USED 
9500 PAYMENTS TO STATES -SPORT FISH 
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The following subactivity costs are excluded from the FY 2007and FY 2008models if the Budget 
Object Code associated with the transaction is 411G. 

Subactivity Code Subactivity Name 
9511 FRESHWATER AQUATIC EDUCATION 
9512 MARINE SPORT FISH RESTORATION 
9513 MARINE AQUATIC EDUCATION 
9514 FRESHWATER SPORT FISH RESTORATION 
9521 FRESHWATER BOATING ACCESS 
9522 MARINE BOATING ACCESS 
9600 REVERTED FUNDS -SPORT FISH 
9664 FA SPORT FISH - ADMINISTRATION   NO LONGER USED 
9671 FA - GRANTS TO COASTAL STATES 
9672 WETLANDS ASSESSMENT - NWI  -TX 
9673 WETLANDS ADMINISTRATION 
9674 FA - COASTAL GRANTS FROM ADMINISTRATION   NO LONGE 
9675 N.A. ACT - COASTAL CONSERVATION 
9676 N.A. ACT - COASTAL GRANTS 
9677 N.A. ACT - COASTAL ADMINISTRATION 
9678 N.A. ACT - C.A.M. 
9679 N.A. - COASTAL GRANTS FROM ADMINISTRATION 
9700 ALASKA OIL SPILL 
9761 NATIONAL OUTREACH - GRANTS 
9771 BOATING INFRASTRUCTURE GRANTS 
9781 MULTI-STATE CONSERVATION PROJECTS 
9782 NATIONAL SURVEY 
9791 MARINE COMMISSIONS GRANTS 
9792 BOATING COUNCIL 
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Appendix C: ABC Crosswalk FY05 to FY06/FY07/FY08 ABC Codes 

 
FY05 

Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

1C 1C: Provide Forensics Support 
for Law Enforcement 

Q5 Q5: Provide Forensics Support 
for Law Enforcement 

1D 
1D: Inventory, Assess, and 
Monitor Marine/Coastal 

T5 T5: Inventory, Assess, and 
Monitor Marine/Coastal 
Habitats 

1E 1E: Evaluate Species for 
Candidate Status 

A3 A3: Evaluate Species for 
Candidate Status 

1F 
1F: Administer Pay and Benefits 

9C 9C: Administer Pay and 
Benefits 

1G 

1G: Manage Cultural Resources 

3A 3A: Manage and Protect 
Cultural and Heritage 
Resources 

1H 1H: Produce and Reintroduce 
Aquatic Species for Non T&E 
Species Conservation 

J2 J2: Produce and Reintroduce 
Aquatic Species for Non T&E 
Species Conservation 

1N 1N: Prepare and Process 
Foreign and CITES Listings 

B6 B6: Prepare and Process 
Foreign Listings 

1P 1P: Stabilize Burned Areas 2L 2L: Stabilize Burned Areas 
1T 1T: Develop Aquatic Habitat 

Management Plans 
S5 S5: Develop Habitat 

Management Plans 
1X 1X: Assist in the Development 

and Monitoring of Wetland 
Mitigation Banks 

V2 
V2: Manage and Protect 
Wetlands 

1Y 1Y: Restore Uplands W3 W3: Restore Uplands 
1Z 1Z: Rehabilitate Lands 

Damaged by Wildland Fire 
2M 2M: Rehabilitate Lands 

Damaged by Wildland Fire 
2B 2B: Control Native Pest Animals 

and Predators 
J5 J5: Conduct Terrestrial Wildlife 

Population Management 
2D 2D: Administer Endangered 

Species Act Grants 
7A 7A: Administer Endangered 

Species Act Grants 
2E 

2E: Provide Litigation Support 
for Section 7 Consultation with 
Other Federal Agencies 

EC EC: Provide Litigation Support 
for Section 7 Consultation to 
Service and Other Federal 
Agencies 

2N 2N: Manage Unintentional Take 
for Non T&E Migratory Birds 

L3 L3: Manage Migratory Bird 
Populations 

2S 2S: Maintain Water Conveyance 
Facilities 

8L 8L: Maintain Water 
Conveyance Facilities 

2T 2T: Develop and Allocate 
Budgets 

9Q 9Q: Develop and Allocate 
Budgets 

2Y 2Y: Process Special Recreation 
Use Permits 

P4 P4: Process Refuge Special 
Use Permits 

3C 3C: Conduct Intra-Service 
Consultations on FWS 
Enhancement and Restoration 
Projects 

EB EB: Provide ESA Section 7 
Intra-Service Consultations to 
Service Programs except for 
Wildland Fire 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

3L 3L: Provide and Manage 
Opportunities for Non-Priority 
Public Uses 

4B 4B: Provide and Manage 
Opportunities for Other Public 
Uses 

3M 3M: Review and Approve 
Policies and Directives 

9B 9B: Conduct Policies and 
Directives Management 

3N 3N: Conduct 5-Year Reviews C4 C4: Conduct 5-Year Reviews 
3O 3O: Prevent, Manage and 

Control Non-Native, Invasive, 
Terrestrial Plants 

N2 N2: Prevent, Manage and 
Control Non-Native, Invasive, 
Terrestrial Plants 

3V 
3V: Administer International 
Grants 

7D 7D: Administer Multinational 
Species Conservation Fund 
Grants 

3W 3W: Acquire IT Investments 9M 9M: Acquire IT Investments 
3Z 3Z: Maintain All Other 

Structures and Facilities 
8M 8M: Maintain All Other 

Structures and Facilities 
4B 4B: Prepare and Process 12-

Month Finding for List or Uplist 
Petition for US/Domestic 
Species 

B2 

B2: Prepare and Process 
Listing Petitions 

4D 4D: Restore Marine and Coastal 
Habitats 

W5 W5: Restore Marine and 
Coastal Habitats 

4F 4F: Perform Financial 
Management Operations 

9R 9R: Perform Financial 
Management Operations 

4G 4G: Restore Natural Resources 
Damaged by Releases of Oil or 
Hazardous Substances 

D2 
D2: Implement Recovery 
Actions for T&E Species 

4K 4K: Implement Recovery 
Actions 

D2 D2: Implement Recovery 
Actions for T&E Species 

4L 4L: Conduct Intra-Service 
Consultation on FWS 
Construction, Operations, and 
Maintenance Activities 

EB EB: Provide ESA Section 7 
Intra-Service Consultations to 
Service Programs except for 
Wildland Fire 

4P 4P: Reduce Fuels - Prescribed 
Fire (WUI) 

2F 2F: Reduce Hazardous Fuels - 
Prescribed Fire (WUI) 

4S 4S: Manage and Protect Marine 
and Coastal Habitats 

V5 V5: Manage and Protect 
Marine and Coastal Habitats 

4V 4V: Conduct Disease Monitoring 
and Treatment for Non T&E 
Species 

J4 J4: Conduct Disease 
Monitoring and Treatment for 
Non T&E Species 

4X 4X: Develop New Aquatic 
Technologies for Non T&E 
Species 

J3 J3: Develop New Aquatic 
Technologies for Non T&E 
Species 

4Z 4Z: Conduct Hydropower 
Consultations with Other 
Federal Agencies 

E4 E4: Provide ESA Section 7 
Consultations for Hydropower 
to Other Federal Agencies 

5A 5A: Conduct Natural Resource 
Damage Assessments 

Y4 Y4: Conduct Natural Resource 
Damage Assessments 

5B 5B: Provide Litigation Support 
for Permitting Actions of T&E 
Species 

F6 F6: Provide Litigation Support 
for Permitting Actions of T&E 
Species 

5H 5H: Prepare 12-Month Finding 
for Delist or Downlist Species 

C5 C5: Prepare and Process 
Delisting/Downlisting Petitions 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

5K 5K: Provide Office Support 9X 9X: Provide Office Support 
5Q 5Q: Prepare and Process 

Downlisting and Delisting Draft 
and Final Rules 

C6 
C6: Prepare and Process 
Delisting/Downlisting Rules 

5R 5R: Manage Competitive 
Sourcing Initiatives 

9U 9U: Conduct Competitive 
Sourcing Initiatives 

5S 5S: Maintain Bridges 8J 8J: Maintain Bridges 
5T 5T: Conduct Refuge Patrol and 

Enforcement 
Q4 Q4: Conduct Refuge Patrol 

and Enforcement 
5U 

5U: Inventory, Assess, and 
Monitor Riparian 

T4 T4: Inventory, Assess, and 
Monitor Riparian/Stream 
Habitats 

5W 5W: Acquire Easements U3 U3: Acquire Easements 
5Z 

5Z: Conduct Forest 
Consultations with Other 
Federal Agencies 

E6 E6: Provide ESA Section 7 
Consultations for Forest 
Resources to Other Federal 
Agencies 

6A 6A: Conduct Contaminant 
Assessments 

X3 X3: Conduct Contaminant 
Assessments 

6D 
6D: Control Native Pest Plants 

V2 V2: Manage and Protect 
Wetlands 

6G 6G: Process Information 
Quality, FOIA, Privacy Act and 
Liability Requests and Claims 

9Z 9Z: Process Information 
Quality, FOIA, Privacy Act and 
Liability Requests/Claims 

6I 6I: Process Migratory Bird 
Permits or Other Take 
Authorizations 

P2 
P2: Process Migratory Bird 
Permits 

6J 
6J: Review and Develop 
Environmental Provisions for 
Projects, Plans, and Permits 

Z2 Z2: Review and Develop 
Environmental Provisions for 
Federal Projects, Plans, and 
Permits 

6K 6K: Manage and Protect 
Riparian/Stream Habitats 

V4 V4: Manage and Protect 
Riparian/Stream Habitats 

6L 6L: Reduce Fuels - Mechanical 
(WUI) 

2G 2G: Reduce Hazardous Fuels - 
Mechanical (WUI) 

6N 
6N: Produce and Reintroduce 
Fish for Recreation 

4A 4A: Provide and Manage 
Opportunities for Quality 
Wildlife Dependent Recreation 

6S 6S: Administer Recruitment, 
Staffing and Ensure Diversity 

9G 9G: Administer Recruitment, 
Staffing and Ensure Diversity 

6U 6U: Process Import and Export 
Licenses 

P6 P6: Process Import and Export 
Licenses 

6V 6V: Ensure Air Quality X5 X5: Ensure Air Quality 
7E 7E: Reduce Hazardous Fuels - 

Other (WUI) 
2H 2H: Reduce Hazardous Fuels - 

Other Methods (WUI) 
7F 7F: Produce and Enhance 

Terrestrial Species 
J5 J5: Conduct Terrestrial Wildlife 

Population Management 
7G 7G: Administer Bird Habitat 

Grants 
7C 7C: Administer Migratory Bird 

Grants 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

7J 7J: Survey, Assess, Monitor 
Non T&E Wildlife and Plants 
Other Than Aquatic and 
Migratory Bird Species  

M7 M7: Survey, Assess, Monitor 
Non T&E Wildlife and Plants 
Other Than Aquatic and 
Migratory Bird Species 

7K 7K: Develop Strategic 
Landscape and Watershed 
Based Plans and Projects 

S4 S4: Develop Strategic 
Landscape Based Plans and 
Projects 

7Q 7Q: Process and Monitor Safe 
Harbor Permit Applications 

F3 F3: Process and Monitor Safe 
Harbor Permit Applications 

7R 7R: Provide Litigation Support 
for Recovery Actions 

D4 D4: Provide Litigation Support 
for Recovery Actions 

7S 7S: Process and Monitor 
Recovery Permits for T&E 
Species 

F5 F5: Process and Monitor 
Recovery Permits for T&E 
Species 

7T 7T: Conduct and Assist with 
Law Enforcement for Non T&E 
Species 

Q2 Q2: Conduct and Assist with 
Law Enforcement for Non T&E 
and Non CITES Listed Species 

7U 7U: Administer Federal 
Assistance Grants 

7B 7B: Administer Federal 
Assistance Grants 

7V 7V: Conduct Resource 
Protection Consultations with 
Other Federal Agencies 

EA EA: Provide All Other ESA 
Section 7 Consultations to 
Other Federal Agencies 

7W 7W: Maintain Equipment 8N 8N: Maintain Equipment 
8G 

8G: Implement Recovery 
Actions for Foreign and CITES 
Species 

R4 R4: Implement CITES Treaty, 
Directives, and Related 
International Obligations and 
Develop Related Policies 

8L 8L: Plan IT Investments 9L 9L: Plan IT Investments 
8R 8R: Develop Bird Conservation 

Plans for Non T&E Species 
K3 K3: Develop Bird Conservation 

Plans for Non T&E Species 
8S 8S: Develop Aquatic Species 

Management Plans for Non 
T&E Species 

K2 K2: Develop Species 
Management Plans for Non 
T&E Species 

8V 

8V: Conduct Environmental 
Consultations – Wildland Fire 

E2 E2: Provide ESA Section 7 
Consultations for Wildland Fire 
to Service and Other Federal 
Agencies 

9A 9A: Attend Non-Program 
Specific Meetings 

93 
93: Attend Training 

9B 
9B: Process and Monitor HCP 
Permit Applications 

F2 F2: Evaluate Need for and 
Process and Monitor HCP 
Permit Applications 

9C 9C: Monitor and Evaluate Fuels 
Reduction and Post-Fire 
Rehabilitation 

2N 2N: Monitor and Evaluate 
Fuels Reduction and Post-Fire 
Rehabilitation 

9D 9D: Attend Training 93 93: Attend Training 
9E 9E: Exchange or Dispose of 

Lands 
U4 U4: Exchange or Dispose of 

Lands 
9F 9F: Suppress Wildland Fires 

outside the WUI 
2J 2J: Suppress Wildland Fires 

(Non-WUI) 
9H 9H: Process Permits for Rights 

of Way 
P3 P3: Process Permits for Rights 

of Way 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

9K 9K: Develop and Manage Co-
Op Land Management 
Agreements 

V2 
V2: Manage and Protect 
Wetlands 

9L 9L: Prevent, Manage and 
Control Invasive Aquatic 
Animals 

N5 N5: Prevent, Manage and 
Control Invasive Aquatic 
Animals 

9N 9N: Reduce Hazardous Fuels - 
Prescribed Fire (Non-WUI) 

2C 2C: Reduce Hazardous Fuels - 
Prescribed Fire (Non-WUI) 

9R 9R: Prepare and Process 
Listing Rules for US/Domestic 
Species 

B3 B3: Prepare and Process 
Listing Rules for US/Domestic 
Species 

9T 9T: Prepare Fire Management 
Plans 

2B 2B: Prepare Fire Management 
Plans 

9V 9V: Mechanically Reduce 
Hazardous Fuels (Non-WUI) 

2D 2D: Reduce Hazardous Fuels - 
Mechanical (Non-WUI) 

9Y 9Y: Manage Records, Files, 
Mailrooms and Libraries/Info. 
Services 

9Y 9Y: Manage Records, Files, 
Mailrooms and Libraries/Info. 
Services 

A1 
A1: Conduct Intra-Service 
Consultation on Other FWS 
Activities 

EB EB: Provide ESA Section 7 
Intra-Service Consultations to 
Service Programs except for 
Wildland Fire 

A2 A2: Provide Litigation Support 
for Listing for US/Domestic 
Species 

B5 B5: Provide Litigation Support 
for Listing of US/Domestic 
Species 

A4 A4: Develop Refuge Harvest 
Regulations for Species Other 
than Birds and Fish 

K2 K2: Develop Species 
Management Plans for Non 
T&E Species 

A5 A5: Consult and Coordinate with 
Native American Tribes 

5E 5E: Consult and Coordinate 
with Native American Tribes 

B1 B1: Operate, Maintain and 
Manage IT Investments 

9P 9P: Operate, Maintain and 
Manage IT Investments 

B2 
B2: Conduct Non-Energy 
Minerals Consultations with 
Other Federal Agencies 

E7 E7: Provide ESA Section 7 
Consultations for Non-Energy 
Minerals to Other Federal 
Agencies 

B3 
B3: Communicate Directly with 
Media 

5A 5A: Conduct External 
Relations - Media, 
Congressional, and Other 

B6 B6: Provide and Manage 
Opportunities for Priority Public 
Uses 

4A 4A: Provide and Manage 
Opportunities for Quality 
Wildlife Dependent Recreation 

B8 
B8: Survey, Assess and Monitor 
Non T&E Aquatic Species 

M2 M2: Survey, Assess and 
Monitor Non T&E Aquatic 
Species 

C2 C2: Maintain Dams and Water 
Storage Facilities 

8K 8K: Maintain Dams and Water 
Storage Facilities 

C4 C4: Manage Contracts and 
Acquisitions 

9W 9W: Manage Purchases, 
Contracts and Acquisitions 

C6 C6: Prepare and Process 
Critical Habitat Rules for 
US/Domestic Species 

B4 B4: Prepare and Process 
Critical Habitat Rules for 
US/Domestic Species 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

C7 C7: Administer Employee and 
Labor Relations 

9D 9D: Administer Employee and 
Labor Relations 

C8 C8: Administer External Civil 
Rights 

9E 9E: Administer External Civil 
Rights 

C9 C9: Administer Internal Civil 
Rights 

9F 9F: Administer Internal Civil 
Rights 

D7 
D7: Monitor and Report 
Performance of Projects, Plans 
and Permits 

Z2 Z2: Review and Develop 
Environmental Provisions for 
Federal Projects, Plans, and 
Permits 

D8 D8: Prevent, Manage and 
Control Invasive Aquatic Plants 

N4 N4: Prevent, Manage and 
Control Invasive Aquatic Plants

E1 E1: Prepare and Process Initial 
List or Uplist Petition Response 
for US/Domestic Species 

B2 
B2: Prepare and Process 
Listing Petitions 

E2 E2: Conduct and Assist with 
Law Enforcement Investigations 
for T&E and CITES Listed 
Species 

G2 G2: Conduct and Assist with 
Law Enforcement 
Investigations for T&E and 
CITES Listed Species 

E5 
E5: Coordinate Congressional 
Communications 

5A 5A: Conduct External 
Relations - Media, 
Congressional, and Other 

E7 
E7: Implement Candidate 
Conservation Actions 

A2 A2: Plan and Implement 
Candidate Conservation 
Actions 

F1 
F1: Conduct Recreation 
Consultations 

E9 E9: Provide ESA Section 7 
Consultations for Recreation to 
Other Federal Agencies 

F3 F3: Conduct Water 
Consultations with Other 
Federal Agencies 

E3 E3: Provide ESA Section 7 
Consultations for Water Use to 
Other Federal Agencies 

G1 
G1: Manage Bird Harvest 

M4 M4: Conduct Migratory Bird 
Surveys and Monitoring 

G5 G5: Conduct Import/Export 
Inspections for T&E and CITES 
Listed Species 

G3 G3: Conduct Import/Export 
Inspections for T&E and 
CITES Listed Species 

G7 G7: Develop and Monitor 
Conservation Banks 

D2 D2: Implement Recovery 
Actions for T&E and CITES 

H2 H2: Implement Bird 
Conservation Plans 

K3 K3: Develop Bird Conservation 
Plans for Non T&E Species 

H4 H4: Construct Water 
Conveyance Facilities 

8E 8E: Construct Water 
Conveyance Facilities 

H9 

H9: Conduct Intra-Service 
Consultations on FWS Permits 

EB EB: Provide ESA Section 7 
Intra-Service Consultations to 
Service Programs except for 
Wildland Fire 

I8 I8: Develop and Manage 
Partnerships' 

5D 5D: Develop and Manage 
Partnerships 

J5 J5: Restore Wetlands W2 W2: Restore Wetlands 
J6 J6: Manage Volunteers and 

Work Programs 
5C 5C: Manage Volunteers and 

Community Partnerships 
J7 J7: Prepare for Wildland Fires 2A 2A: Prepare for Wildland Fires 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

J8 J8: Resolve Bird Resource 
Conflicts for Non T&E Species 

L3 L3: Manage Migratory Bird 
Populations 

K2 K2: Manage and Protect 
Uplands 

V3 V3: Manage and Protect 
Uplands 

K3 K3: Provide Services for 
Facilities and Space 
Management 

8A 8A: Provide Leased Space 
Operations and Program 
Management 

K5 K5: Maintain Roads 8H 8H: Maintain Roads 
K8 K8: Process Designated Port 

Exception Permits 
P7 P7: Process Designated Port 

Exception Permits 
L1 L1: Suppress Wildland Fires in 

the WUI 
2K 2K: Suppress Wildland Fires 

(WUI) 
L7 L7: Inventory, Assess, and 

Monitor Wetlands 
T2 T2: Inventory, Assess, and 

Monitor Wetlands 
L9 L9: Clean up Contaminants on 

Service Lands 
X4 X4: Clean up Contaminated 

Service Lands 
M3 M3: Manage Museum 

Collections 
3B 3B: Manage and Protect 

Museum Items 
M8 M8: Acquire and Manage Real 

Estate 
U2 U2: Acquire and Manage Real 

Estate 
M9 M9: Make Refuge Revenue 

Sharing Payments 
U2 U2: Acquire and Manage Real 

Estate 
N1 N1: Construct Buildings 8B 8B: Construct Buildings 
N2 N2: Inventory DOI Facilities and 

Assess Facility Condition 
8P 8P: Inventory DOI Facilities 

and Assess Facility Condition 
N3 N3: Process Refuge Special 

Use/Recreation Commercial 
Permits 

P4 
P4: Process Refuge Special 
Use Permits 

N4 N4: Conduct Forage 
Consultations with Other 
Federal Agencies 

E5 E5: Provide ESA Section 7 
Consultations for Forage to 
Other Federal Agencies 

N9 N9: Construct All Other 
Structures and Facilities 

8F 8F: Construct All Other 
Structures and Facilities 

O5 
O5: Conduct Strategic Planning 
and Performance Management 

9S 9S: Conduct Strategic 
Planning and Performance 
Management 

O6 
O6: Process International Trade 
Permits, Domestic Permits and 
Special Use Permits 

P5 P5: Process International 
Trade Permits, Domestic 
Permits and Special Use 
Permits 

O7 

O7: Conduct Intra-Service 
Consultations on FWS Grants 

EB EB: Provide ESA Section 7 
Intra-Service Consultations to 
Service Programs except for 
Wildland Fire 

O9 O9: Develop Recovery Plans for 
T&E Species 

C2 C2: Develop Recovery Plans 
for T&E Species 

P1 P1: Reduce Hazardous Fuels - 
Other Methods (Non-WUI) 

2E 2E: Reduce Hazardous Fuels - 
Other Methods (Non-WUI) 

P2 P2: Manage Marine Mammal 
Harvests 

L5 L5: Manage Marine Mammal 
Harvest and Take 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

P7 P7: Evaluate and Audit 
Environmental Safety and 
Compliance 

X2 X2: Evaluate and Audit 
Environmental Safety and 
Compliance 

P8 P8: Process and Monitor 
Candidate Conservation 
Agreements with Assurances 

F4 F4: Process and Monitor 
Candidate Conservation 
Agreements with Assurances 

Q1 Q1: Inventory, Assess, and 
Monitor Uplands 

T3 T3: Inventory, Assess, and 
Monitor Uplands 

Q4 Q4: Develop and Deliver 
Training 

92 92: Develop and Deliver 
Training 

Q6 Q6: Develop and Provide 
Information and Educational 
Materials and Activities 

5B 5B: Develop and Provide 
Information and Educational 
Materials and Activities 

Q7 Q7: Survey, Assess and Monitor 
Non T&E Migratory Birds 

M4 M4: Conduct Migratory Bird 
Surveys and Monitoring 

Q8 Q8: Conduct Workforce 
Planning 

9H 9H: Conduct Workforce 
Planning 

R2 R2: Analyze Organizational 
Structures and Classify 
Positions 

9G 
9G: Administer Recruitment, 
Staffing and Ensure Diversity 

R8 R8: Provide Non-Trust 
Resource Enforcement 
Activities 

6B 

6B: Conduct Security Activities 
S1 S1: Construct Roads, Bridges, 

Tunnels 
8C 8C: Construct Roads, Bridges, 

Tunnels 
S2 S2: Review Hazardous Waste 

Actions 
Y3 Y3: Review Hazardous Waste 

Actions 
S3 S3: Maintain Surface and 

Groundwater Systems 
U6 U6: Manage Water Quality and 

Quantity 
S9 S9: Conduct Energy 

Consultations with Other 
Federal Agencies 

E8 E8: Provide ESA Section 7 
Consultations for Energy to 
Other Federal Agencies 

T2 T2: Manage and Protect 
Wetlands 

V2 V2: Manage and Protect 
Wetlands 

T5 T5: Manage Marine Mammal 
Incidental Take 

L5 L5: Manage Marine Mammal 
Harvest and Take 

T8 T8: Provide Directorate 
Leadership and Oversight 

9A 9A: Provide Directorate 
Leadership and Oversight 

T9 T9: Prepare Initial Response to 
Delist or Downlist Petition 

C5 C5: Prepare and Process 
Delisting/Downlisting Petitions 

U7 U7: Manage Alaska 
Subsistence Harvest Other 
Than Marine Mammals 

L6 L6: Manage Alaska 
Subsistence Harvest Other 
Than Marine Mammals 

U8 
U8: Administer Other Grants 
and Co-operative Agreements 

7E 7E: Administer Other Domestic 
and International Grants and 
Co-operative Agreements   

V4 V4: Provide Emergency 
Response and Public Safety 
Operations 

6A 6A: Provide Emergency 
Response and Public Safety 
Operations 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

V7 
V7: Prepare and Process 
Special 4d and Experimental 
Population Rules 

C3 C3: Prepare, Process and 
Implement Special 4d, 
Experimental Population and 
Other Rules for T&E Species 

W1 W1: Review and Develop 
Environmental Provisions for 
FERC Hydropower Projects – 
Non-Specific (COM)  

Z5 Z5: Review and Develop 
Environmental Provisions for 
FERC Hydropower Projects - 
Non-Specific (COM) 

W2 W2: Plan and Implement Post-
Delisting Monitoring 

D3 D3: Plan and Implement Post-
Delisting Monitoring 

W3 W3: Process Litigation for 
Recreation 

4D 4D: Process Litigation for 
Recreation 

W4 

W4: Implement Bi-national and 
Multinational Initiatives 

R5 R5: Implement Provisions of 
Other Bilateral and 
Multinational Agreements, 
Treaties, Accords and Orders 

W5 
W5: Process Non-T&E Litigation 
for Resource Protection 

H2 H2: Process Non-T&E 
Litigation for Resource 
Protection 

W6 W6: Maintain Buildings 8G 8G: Maintain Buildings 
W7 W7: Review and Develop 

Environmental Provisions for 
FERC Hydropower Projects – 
Municipal (MUN) 

Z3 Z3: Review and Develop 
Environmental Provisions for 
FERC Hydropower Projects - 
Municipal (MUN) 

W8 W8: Manage Harvest for 
Fisheries 

L4 L4: Manage Harvest for 
Fisheries 

W9 W9: Review and Develop 
Environmental Provisions for 
FERC Hydropower Projects – 
Non-Municipal (PUB) 

Z4 Z4: Review and Develop 
Environmental Provisions for 
FERC Hydropower Projects - 
Non-Municipal (PUB) 

X2 X2: Develop Land Conservation 
Plans 

S2 S2: Develop Land Protection 
Plans 

X3 X3: Prepare for and Implement 
Spill Response Plans 

Y2 Y2: Prepare for and Implement 
Spill Response Plans 

X4 X4: Evaluate and Counsel 
Personnel 

9J 9J: Evaluate and Counsel 
Personnel 

X5 
X5: Collect and Analyze Activity 
Based Costing Information 

9T 9T: Collect and Analyze 
Activity Based Costing 
Information 

X8 X8: Develop Comprehensive 
Conservation Plans 

S3 S3: Develop Comprehensive 
Conservation Plans 

Y2 Y2: Construct Dams and Water 
Storage Facilities 

8D 8D: Construct Dams and 
Water Storage Facilities 

Y3 
Y3: Conduct Non T&E 
Import/Export Inspections 

Q3 Q3: Conduct Import/Export 
Inspections of Non T&E and 
Non CITES Listed Species 

Y8 Y8: Prevent, Manage and 
Control Non-Native, Invasive 
Terrestrial Animals 

N3 N3: Prevent, Manage and 
Control Non-Native, Invasive 
Terrestrial Animals 

Z6 Z6: Restore Riparian/Stream 
Habitats 

W4 W4: Restore Riparian/Stream 
Habitats 
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FY05 
Activity 
Code 

FY05 Activity Name FY06/FY07/FY08 
Activity Code 

FY06/FY07/FY08 Activity 
Name 

Z9 Z9: Manage Special 
Designation Areas 

U5 
U5: Manage Wilderness Areas 
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Appendix D: Organization Crosswalk as of FY 2007 Q4 
 

Old Org 
Code 

New Org 
Code 

Org Code Description 

10001 14245 EAGLE FISH HEALTH LABORATORY 
10003 14260 MAGIC VALLEY FISH HATCHERY 
10101 80200 MANAGER-CALIFORNIA/NEVADA OPERATIONS OFFICE 
10106 81660 KLAMATH BASIN NATIONAL WILDLIFE REFUGE COMPLEX 
10107 84550 DESERT NATIONAL WILDLIFE REFUGE COMPLEX 
10108 81660 KLAMATH BASIN NATIONAL WILDLIFE REFUGE COMPLEX 
10112 80200 MANAGER-CALIFORNIA/NEVADA OPERATIONS OFFICE 
10113 80211 ASSISTANT MANAGER-CONSERVATION PARTNERSHIPS 
10138 80235 DIVISION OF REALTY 
10170 10185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
11240 81240 COLEMAN NATIONAL FISH HATCHERY 
11330 81330 RED BLUFF FISH AND WILDLIFE OFFICE 
11331 81331 ARCATA FISH AND WILDLIFE OFFICE 
11332 81332 STOCKTON FISH AND WILDLIFE OFFICE 
11333 81333 YREKA FISH AND WILDLIFE OFFICE 
11420 81420 SACRAMENTO FISH AND WILDLIFE OFFICE 
11430 81430 CARLSBAD FISH AND WILDLIFE OFFICE 
11440 81440 VENTURA FISH AND WILDLIFE OFFICE 
11450 81450 KLAMATH FALLS FISH AND WILDLIFE OFFICE 
11590 81590 HUMBOLDT BAY NATIONAL WILDLIFE REFUGE 
11614 11671 BLUE RIDGE NATIONAL WILDLIFE REFUGE 
11615 11672 BITTER CREEK NATIONAL WILDLIFE REFUGE  
11620 81620 SACRAMENTO NATIONAL WILDLIFE REFUGE COMPLEX 
11630 81630 SONNY BONO SALTON SEA NATIONAL WILDLIFE REFUGE 

COMPLEX 
11640 81640 SAN FRANCISCO BAY NATIONAL WILDLIFE REFUGE COMPLEX 
11650 81650 SAN LUIS NATIONAL WILDLIFE REFUGE COMPLEX 
11660 81660 KLAMATH BASIN NATIONAL WILDLIFE REFUGE COMPLEX 
11666 81666 BEAR VALLEY NATIONAL WILDLIFE REFUGE 
11680 81680 SAN DIEGO NATIONAL WILDLIFE REFUGE COMPLEX 
11690 81690 MODOC NATIONAL WILDLIFE REFUGE 
11710 81710 STONE LAKES NATIONAL WILDLIFE REFUGE 
14240 84240 LAHONTAN NATIONAL FISH HATCHERY 
14320 84320 NEVADA FISH AND WILDLIFE OFFICE 
14550 84550 DESERT NATIONAL WILDLIFE REFUGE COMPLEX 
14570 84570 RUBY LAKE NATIONAL WILDLIFE REFUGE 
14590 84590 STILLWATER NATIONAL WILDLIFE REFUGE 
19200 99110 SPECIAL AGENT IN CHARGE-PORTLAND, OREGON 
19210 99111 RESIDENT AGENT IN CHARGE-REDMOND, WASHINGTON 
19211 99116 SPECIAL AGENT-OLYMPIA, WASHINGTON 
19213 99113 SPECIAL AGENT-BELLINGHAM, WASHINGTON 
19214 99114 SPECIAL AGENT-VANCOUVER, WASHINGTON 
19222 99120 RESIDENT AGENT IN CHARGE-WILSONVILLE, OREGON 
19223 99121 SPECIAL AGENT-KLAMATH FALLS, OREGON 
19224 99112 WILDLIFE INSPECTOR-BLAINE, WASHINGTON 
19230 99130 RESIDENT AGENT IN CHARGE-BOISE, IDAHO 
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Old Org 
Code 

New Org 
Code 

Org Code Description 

19231 99131 SPECIAL AGENT-IDAHO FALLS, IDAHO 
19232 99117 SPECIAL AGENT-SPOKANE, WASHINGTON 
19240 99140 RESIDENT AGENT IN CHARGE-HONOLULU, HAWAII 
19241 99141 SPECIAL AGENT-AGANA, GUAM 
19310 99150 RESIDENT AGENT IN CHARGE-SACRAMENTO, CALIFORNIA 
19312 99151 SPECIAL AGENT-CHICO, CALIFORNIA 
19320 99152 SPECIAL AGENT-BURLINGAME, CALIFORNIA 
19324 99153 SPECIAL AGENT-CLOVIS, CALIFORNIA 
19330 99160 RESIDENT AGENT IN CHARGE-TORRANCE, CALIFORNIA 
19332 99161 SPECIAL AGENT-LOS OSOS, CALIFORNIA 
19333 99162 SPECIAL AGENT-SAN DIEGO, CALIFORNIA 
19340 99134 SPECIAL AGENT-RENO, NEVADA 
19342 99135 SPECIAL AGENT-LAS VEGAS, NEVADA 
20131 20151 DIVISION OF MIGRATORY BIRDS 
20133 20191 CULTURAL RESOURCES 
20152 20141 DIVISION OF FISHERIES 
20154 20124 DIVISION OF ENDANGERED SPECIES AND HABITAT 

CONSERVATION 
20191 20125 NATIONAL WETLANDS INVENTORY 
20200 20140 ASSISTANT REGIONAL DIRECTOR-FISHERIES 
20300 20120 ASSISTANT REGIONAL DIRECTOR-ECOLOGICAL SERVICES 
21231 21230 SAN MARCOS NATIONAL FISH HATCHERY AND FISH 

TECHNOLOGY CENTER 
21241 21310 OKLAHOMA FISHERY RESOURCES OFFICE 
21250 21320 TEXAS FISHERY RESOURCES OFFICE-AUSTIN, TEXAS 
21540 21543 BRAZORIA NATIONAL WILDLIFE REFUGE 
21620 21661 OPTIMA NATIONAL WILDLIFE REFUGE 
22340 22351 ARIZONA FISHERY RESOURCES OFFICE-PARKER 
22360 22353 ARIZONA FISHERY RESOURCES OFFICE-FLAGSTAFF 
29600 99210 SPECIAL AGENT IN CHARGE-ALBUQUERQUE, NEW MEXICO 
29610 99230 RESIDENT AGENT IN CHARGE-MESA, ARIZONA 
29611 99231 SPECIAL AGENT-YUMA, ARIZONA 
29613 99213 SPECIAL AGENT-EL PASO, TEXAS 
29615 99233 SPECIAL AGENT-FLAGSTAFF, ARIZONA 
29616 99234 SPECIAL AGENT-NOGALES, ARIZONA 
29617 99235 SPECIAL AGENT-PINETOP, ARIZONA 
29620 99250 RESIDENT AGENT IN CHARGE-SAN ANTONIO, TEXAS 
29621 99251 SPECIAL AGENT-MCALLEN, TEXAS 
29622 99252 SPECIAL AGENT-LAREDO, TEXAS 
29623 99253 SPECIAL AGENT-CORPUS CHRISTI, TEXAS 
29624 99222 SPECIAL AGENT-VICTORIA, TEXAS 
29625 99255 WILDLIFE INSPECTOR-BROWNSVILLE, TEXAS 
29626 99256 SPECIAL AGENT-AUSTIN, TEXAS 
29627 99257 SPECIAL AGENT-ALPINE, TEXAS 
29629 99258 SPECIAL AGENT-LOS INDIOS, TEXAS 
29630 99243 SPECIAL AGENT-FORT WORTH, TEXAS 
29631 99241 SPECIAL AGENT-DALLAS/FORT WORTH AIRPORT, TEXAS 
29640 99220 RESIDENT AGENT IN CHARGE-HOUSTON, TEXAS 
29641 99221 SPECIAL AGENT-BEAUMONT, TEXAS 
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Old Org 
Code 

New Org 
Code 

Org Code Description 

29650 99240 RESIDENT AGENT IN CHARGE-OKLAHOMA CITY, OKLAHOMA 
29653 99212 SPECIAL AGENT-LUBBOCK, TEXAS 
29654 99242 SPECIAL AGENT-TULSA, OKLAHOMA 
29660 99211 RESIDENT AGENT IN CHARGE-ALBUQUERQUE, NEW MEXICO 
30110 30186 DIVISION OF INFORMATION TECHNOLOGY MANAGEMENT 
30124 30127 ILLINOIS PRIVATE LANDS OFFICE 
30131 30151 DIVISION OF MIGRATORY BIRDS 
30134 31560 PATOKA RIVER NATIONAL WILDLIFE REFUGE 
30139 32630 CYPRESS CREEK NATIONAL WILDLIFE REFUGE 
30141 32141 LA CROSSE FISH HEALTH CENTER 
30143 32143 COLUMBIA FISHERIES RESOURCE OFFICE 
30144 30122 DIVISION OF ENDANGERED SPECIES 
30145 32145 MARQUETTE BIOLOGICAL STATION 
30146 32146 LUDINGTON BIOLOGICAL STATION 
30147 33670 NEAL SMITH NATIONAL WILDLIFE REFUGE 
30148 32148 GREAT LAKES COORDINATION OFFICE 
30150 30152 DIVISION OF FEDERAL ASSISTANCE 
30170 30185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
39700 99310 SPECIAL AGENT IN CHARGE-FORT SNELLING, MINNESOTA 
39710 99311 RESIDENT AGENT IN CHARGE-ST. PAUL, MINNESOTA 
39711 99331 WILDLIFE INSPECTOR-MINNEAPOLIS/ST. PAUL INTERNATIONAL 

AIRPORT 
39712 99316 SPECIAL AGENT-DULUTH, MINNESOTA 
39721 99312 SPECIAL AGENT-MADISON, WISCONSIN 
39722 99313 SPECIAL AGENT-ONALASKA, WISCONSIN 
39724 99314 SPECIAL AGENT-GREEN BAY, WISCONSIN 
39730 99330 SUPERVISORY WILDLIFE INSPECTOR-ROSEMONT, ILLINOIS 
39740 99340 RESIDENT AGENT IN CHARGE-ANN ARBOR, MICHIGAN 
39741 99332 WILDLIFE INSPECTOR-DETROIT AIRPORT 
39742 99341 SPECIAL AGENT-BAY CITY, MICHIGAN 
39743 99342 SPECIAL AGENT-GRAND RAPIDS, MICHIGAN 
39744 99351 SPECIAL AGENT-ROSEMONT, ILLINOIS 
39750 99350 RESIDENT AGENT IN CHARGE-SPRINGFIELD, ILLINOIS 
39751 99352 SPECIAL AGENT-PEORIA, ILLINOIS 
39752 99353 SPECIAL AGENT-BARRINGTON, ILLINOIS 
39761 99343 SPECIAL AGENT-COLUMBUS, OHIO 
39762 99344 SPECIAL AGENT-SANDUSKY, OHIO 
39763 99354 SPECIAL AGENT-FRANKLIN, INDIANA 
39770 99370 RESIDENT AGENT IN CHARGE-JEFFERSON CITY, MISSOURI 
39772 99371 SPECIAL AGENT-ST. PETERS, MISSOURI 
39773 99372 SPECIAL AGENT-INDEPENDENCE, MISSOURI 
39781 99373 SPECIAL AGENT-DES MOINES, IOWA 
40141 41141 GULF COAST FISHERIES COORDINATION OFFICE 
40153 40123 DIVISION OF ECOLOGICAL SERVICES-PERMANENT CHANGE OF 

STATION ACCOUNT 
40170 40185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
41235 41280 WARM SPRINGS REGIONAL FISHERIES CENTER 
41240 41286 WARM SPRINGS NATIONAL FISH HATCHERY 
41241 41288 BEARS BLUFF NATIONAL FISH HATCHERY 
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41245 41284 WARM SPRINGS FISH HEALTH CENTER 
41514 41516 CRYSTAL RIVER NATIONAL WILDLIFE REFUGE 
43680 43682 YAZOO NATIONAL WILDLIFE REFUGE 
43682 43680 THEODORE ROOSEVELT NATIONAL WILDLIFE REFUGE 

COMPLEX 
49900 99410 SPECIAL AGENT IN CHARGE-ATLANTA, GEORGIA 
49910 99411 RESIDENT AGENT IN CHARGE-ATLANTA, GEORGIA 
49911 99416 WILDLIFE INSPECTOR-ATLANTA PORT, GEORGIA 
49912 99412 SPECIAL AGENT-SAVANNAH, GEORGIA 
49913 99413 SPECIAL AGENT-MONTGOMERY, ALABAMA 
49914 99414 SPECIAL AGENT-DAPHNE, ALABAMA 
49915 99415 SPECIAL AGENT-ALBANY, GEORGIA 
49920 99420 RESIDENT AGENT IN CHARGE-TAMPA, FLORIDA 
49921 99421 SPECIAL AGENT-TALLAHASSEE, FLORIDA 
49922 99422 SPECIAL AGENT-ORLANDO, FLORIDA 
49923 99423 SPECIAL AGENT-FORT MYERS, FLORIDA 
49924 99424 SPECIAL AGENT-PANAMA CITY, FLORIDA 
49925 99425 SPECIAL AGENT-GAINESVILLE, FLORIDA 
49926 99426 SPECIAL AGENT-JACKSONVILLE, FLORIDA 
49930 99430 RESIDENT AGENT IN CHARGE-MIAMI, FLORIDA 
49931 99431 WILDLIFE INSPECTOR-MIAMI PORT, FLORIDA 
49932 99432 SPECIAL AGENT-SAN JUAN, PUERTO RICO 
49933 99433 SPECIAL AGENT-MAYAGUEZ, PUERTO RICO 
49940 99440 RESIDENT AGENT IN CHARGE-JACKSON, MISSISSIPPI 
49941 99441 SPECIAL AGENT-LITTLE ROCK, ARKANSAS 
49942 99442 SPECIAL AGENT-NATCHEZ, MISSISSIPPI 
49943 99443 SPECIAL AGENT-GRENADA, MISSISSIPPI 
49945 99445 SPECIAL AGENT-HATTIESBURG, MISSISSIPPI 
49946 99446 SPECIAL AGENT-JONESBORO, ARKANSAS 
49948 99448 SPECIAL AGENT-DUMAS, ARKANSAS 
49960 99460 RESIDENT AGENT IN CHARGE-NASHVILLE, TENNESSEE 
49961 99461 SPECIAL AGENT-MEMPHIS, TENNESSEE 
49962 99462 SPECIAL AGENT-LOUISVILLE, KENTUCKY 
49963 99463 SPECIAL AGENT-PADUCAH, KENTUCKY 
49970 99470 RESIDENT AGENT IN CHARGE-RALEIGH, NORTH CAROLINA 
49971 99471 SPECIAL AGENT-WASHINGTON, NORTH CAROLINA 
49972 99472 SPECIAL AGENT-COLUMBIA, SOUTH CAROLINA 
49973 99473 SPECIAL AGENT-ASHEVILLE, NORTH CAROLINA 
49974 99474 SPECIAL AGENT-CHARLESTON, SOUTH CAROLINA 
49980 99480 RESIDENT AGENT IN CHARGE-SLIDELL, LOUISIANA 
49981 99481 WILDLIFE INSPECTOR-NEW ORLEANS, LOUISIANA 
49982 99482 SPECIAL AGENT-BATON ROUGE, LOUISIANA 
49983 99483 SPECIAL AGENT-MONROE, LOUISIANA 
49984 99484 SPECIAL AGENT-LAKE CHARLES, LOUISIANA 
49985 99485 SPECIAL AGENT-LAFAYETTE, LOUISIANA 
49986 99486 SPECIAL AGENT-ALEXANDRIA, LOUISIANA 
49987 99487 SPECIAL AGENT-HOUMA, LOUISIANA 
50170 50185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
59100 99511 RESIDENT AGENT IN CHARGE-BALTIMORE, MARYLAND 
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59110 99513 SPECIAL AGENT-CAMBRIDGE, MARYLAND 
59111 99514 SPECIAL AGENT-DOVER, DELAWARE 
59112 99512 SPECIAL AGENT-ANNAPOLIS, MARYLAND 
59120 99542 SPECIAL AGENT-HARRISBURG, PENNSYLVANIA 
59121 99543 SPECIAL AGENT-PHILADELPHIA, PENNSYLVANIA 
59130 99520 RESIDENT AGENT IN CHARGE-RICHMOND, VIRGINIA 
59131 99521 SPECIAL AGENT-FREDERICKSBURG, VIRGINIA 
59132 99522 SPECIAL AGENT-CHARLESTON, WEST VIRGINIA 
59134 99523 SPECIAL AGENT-ABINGDON, VIRGINIA 
59200 99530 RESIDENT AGENT IN CHARGE-VALLEY STREAM, NEW YORK 
59210 99531 SPECIAL AGENT-ALBANY, NEW YORK 
59211 99532 SPECIAL AGENT-AMHERST, NEW YORK 
59214 99533 WILDLIFE INSPECTOR-CHAMPLAIN, NEW YORK 
59221 99540 RESIDENT AGENT IN CHARGE-ELIZABETH, NEW JERSEY 
59222 99541 SPECIAL AGENT-MILLVILLE, NEW JERSEY 
59224 99542 SPECIAL AGENT-HARRISBURG, PENNSYLVANIA 
59225 99543 SPECIAL AGENT-PHILADELPHIA, PENNSYLVANIA 
59300 99510 SPECIAL AGENT IN CHARGE-HADLEY, MASSACHUSETTS 
59310 99550 RESIDENT AGENT IN CHARGE-CHELSEA, MASSACHUSETTS 
59312 99551 SPECIAL AGENT-HARTFORD, CONNECTICUT 
59320 99552 SPECIAL AGENT-PORTSMOUTH, NEW HAMPSHIRE 
59322 99553 SPECIAL AGENT-ESSEX JUNCTION, VERMONT 
59323 99554 SPECIAL AGENT-EAST ORLAND, MAINE 
59324 99555 SPECIAL AGENT-CHARLESTOWN, RHODE ISLAND 
60141 61270 BOZEMAN FISH HEALTH CENTER 
60170 60185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
60179 61593 STRIKE TEAM INVASIVES 
61420 61810 MONTANA PARTNERS FOR FISH AND WILDLIFE 
61430 61820 WYOMING PARTNERS FOR FISH AND WILDLIFE 
62440 62830 NORTH DAKOTA PARTNERS FOR FISH AND WILDLIFE 
64450 64860 KANSAS PARTNERS FOR FISH AND WILDLIFE 
64460 64850 NEBRASKA PARTNERS FOR FISH AND WILDLIFE 
64470 64840 SOUTH DAKOTA PARTNERS FOR FISH AND WILDLIFE 
65414 65870 COLORADO PARTNERS FOR FISH AND WILDLIFE 
65480 65880 UTAH PARTNERS FOR FISH AND WILDLIFE  
69400 99610 SPECIAL AGENT IN CHARGE-LAKEWOOD, COLORADO 
69402 99023 NATIONAL EAGLE AND WILDLIFE PROPERTY REPOSITORY 
69410 99611 SPECIAL AGENT-BILLINGS, MONTANA 
69411 99612 WILDLIFE INSPECTOR-SWEETGRASS, MONTANA 
69413 99613 SPECIAL AGENT-MISSOULA, MONTANA 
69414 99614 SPECIAL AGENT-BOZEMAN, MONTANA  
69416 99642 SPECIAL AGENT-GRAND JUNCTION, COLORADO 
69417 99620 RESIDENT AGENT IN CHARGE-CASPER, WYOMING 
69418 99621 SPECIAL AGENT-CODY, WYOMING 
69419 99622 SPECIAL AGENT-LANDER, WYOMING 
69420 99650 RESIDENT AGENT IN CHARGE-OGDEN, UTAH 
69421 99651 SPECIAL AGENT-CEDAR CITY, UTAH 
69422 99640 RESIDENT AGENT IN CHARGE-LITTLETON, COLORADO 
69423 99642 SPECIAL AGENT-GRAND JUNCTION, COLORADO 
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69424 99641 WILDLIFE INSPECTOR-DENVER INTERNATIONAL AIRPORT 
69430 99661 SPECIAL AGENT-BISMARCK, NORTH DAKOTA 
69433 99662 SPECIAL AGENT-COLUMBIA, SOUTH DAKOTA 
69442 99630 SPECIAL AGENT-DERBY, KANSAS 
69443 99633 SPECIAL AGENT-TOPEKA, KANSAS 
69444 99632 SPECIAL AGENT-NORTH PLATTE, NEBRASKA 
69445 99631 SPECIAL AGENT-LINCOLN, NEBRASKA 
69450 99660 RESIDENT AGENT IN CHARGE-PIERRE, SOUTH DAKOTA 
69451 99663 WILDLIFE INSPECTOR-DUNSEITH, NORTH DAKOTA 
69452 99664 SPECIAL AGENT-RAPID CITY, SOUTH DAKOTA 
69453 99661 SPECIAL AGENT-BISMARCK, NORTH DAKOTA 
69455 99662 SPECIAL AGENT-COLUMBIA, SOUTH DAKOTA 
69460 99631 SPECIAL AGENT-LINCOLN, NEBRASKA 
69461 99632 SPECIAL AGENT-NORTH PLATTE, NEBRASKA 
70170 70185 DIVISION OF DIVERSITY AND CIVIL RIGHTS 
71100 70120 ASSISTANT REGIONAL DIRECTOR-ECOLOGICAL SERVICES AND 

FISHERIES 
71101 70121 DIVISION OF ECOLOGICAL SERVICES AND FISHERIES 
71102 70122 DIVISION OF FISHERIES AND HABITAT CONSERVATION 
71103 70123 BRANCH OF HABITAT CONSERVATION 
72100 70130 REGIONAL CHIEF-NATIONAL WILDLIFE REFUGE SYSTEM 
72104 70133 DIVISION OF CONSERVATION PLANNING AND POLICY 
72105 70134 AVIATION MANAGER 
72110 70135 DIVISION OF REALTY 
72120 70136 DIVISION OF WATER RESOURCES 
72130 70154 DIVISION OF MIGRATORY BIRDS 
72150 70137 DIVISION OF NATURAL RESOURCES 
73102 70125 BRANCH OF FISHERIES 
73103 70150 ASSISTANT REGIONAL DIRECTOR-MIGRATORY BIRDS AND 

STATE PROGRAMS 
73190 70190 DIVISION OF ENGINEERING 
79100 99710 SPECIAL AGENT IN CHARGE-ANCHORAGE, ALASKA 
79110 99711 RESIDENT AGENT IN CHARGE-ANCHORAGE, ALASKA 
79112 99712 SPECIAL AGENT-KING SALMON, ALASKA 
79113 99713 SPECIAL AGENT-BETHEL, ALASKA 
79115 99715 SPECIAL AGENT-JUNEAU, ALASKA 
79116 99716 LAKE HOOD SEAPLANE BASE WILDLIFE ADMINISTRATIVE SITE 
79117 99717 LEWIS RIVER ADMINISTRATIVE SITE 
79118 99718 PILOT POINT ADMINISTRATIVE SITE 
79119 99719 KUSTATAN RIVER ADMINISTRATIVE SITE 
79120 99720 RESIDENT AGENT IN CHARGE-FAIRBANKS, ALASKA 
79121 99721 SPECIAL AGENT-NOME, ALASKA 
91040 95110 BRANCH OF DIVERSITY AND CIVIL RIGHTS-JOB CORPS UNIT 
91080 91100 DIVISION OF BIRD HABITAT CONSERVATION 
91110 97300 NATIONAL CONSERVATION TRAINING CENTER 
91120 97310 NATIONAL CONSERVATION TRAINING CENTER-DIVISION OF 

FACILITY OPERATIONS 
91130 97340 NATIONAL CONSERVATION TRAINING CENTER-PUBLICATIONS 

AND TRAINING MATERIALS 
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91150 97350 NATIONAL CONSERVATION TRAINING CENTER-DIVISION OF 
EDUCATION 

92110 92200 DIVISION OF ENDANGERED SPECIES 
92213 94300 DIVISION OF HABITAT AND RESOURCE CONSERVATION 
92223 94420 PATUXENT ANALYTICAL CONTROL FACILITY 
92240 94310 NATIONAL WETLANDS INVENTORY 
92331 94311 NATIONAL WETLANDS INVENTORY CENTER 
93470 99010 DIVISION CHIEF-LAW ENFORCEMENT OPERATIONS 
93472 99012 SPECIAL AGENT IN CHARGE-SPECIAL OPERATIONS BRANCH 
93474 99013 SPECIAL AGENT IN CHARGE-TRAINING/INSPECTION BRANCH 
93478 99030 CLARK R. BAVIN NATIONAL FISH AND WILDLIFE FORENSICS 

LABORATORY 
93480 91200 DIVISION OF MIGRATORY BIRD MANAGEMENT 
93510 93200 DIVISION OF REFUGES 
93520 93300 DIVISION OF REALTY 
97400 91400 DIVISION OF FEDERAL ASSISTANCE 
97401 91410 BRANCH OF FEDERAL AID-BRANCH OF TRAINING 
97404 91420 BRANCH OF FEDERAL AID-FEDERAL AID INFORMATION 

MANAGEMENT SYSTEM 
97500 91500 CONSERVATION PARTNERSHIPS LIAISON DIVISION 
97510 91510 SPORT FISHING AND BOATING PARTNERSHIP COUNCIL 
97520 91520 RECREATIONAL BOATING AND FISHING FOUNDATION 
98110 98100 DIVISION OF SAFETY AND HEALTH 
98211 98210 BRANCH OF ACQUISITION AND ASSISTANCE OPERATIONS 
98214 98230 BRANCH OF POLICY AND INFORMATION MANAGEMENT 
98301 98310 BRANCH OF NATIONAL FINANCIAL POLICY AND ANALYSIS 
98302 98320 BRANCH OF FISCAL POLICY AND WASHINGTON OFFICE 

FINANCE ACTIVITIES 
98400 90210 CHIEF-DIVISION OF INFORMATION RESOURCES AND 

TECHNOLOGY MANAGEMENT 
98410 90220 BRANCH OF DATA AND SYSTEMS SERVICES 
98415 90240 BRANCH OF TECHNICAL SERVICES 
98420 90230 BRANCH OF COMMUNICATION TECHNOLOGY 
98425 90250 BRANCH OF PROGRAM AND INFORMATION MANAGEMENT 
98690 98500 DIVISION OF ENGINEERING 
98691 98510 BRANCH OF DAM SAFETY 
98692 98520 BRANCH OF ENGINEERING SERVICES WASHINGTON OFFICE 
98696 98540 BRANCH OF ENVIRONMENTAL AND FACILITY COMPLIANCE 
99100 99010 DIVISION CHIEF-LAW ENFORCEMENT OPERATIONS 
99200 99012 SPECIAL AGENT IN CHARGE-SPECIAL OPERATIONS BRANCH 
99201 99013 SPECIAL AGENT IN CHARGE-TRAINING/INSPECTION BRANCH 
99300 99030 CLARK R. BAVIN NATIONAL FISH AND WILDLIFE FORENSICS 

LABORATORY 
99400 99023 NATIONAL EAGLE AND WILDLIFE PROPERTY REPOSITORY 
99700 98920 CLEARING ACCOUNT-DISTRIBUTION 

 


